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Zotero basics and setup



Zotero is the right tool to…

1. Gather references: Add citation information about, and copies of, 
scholarly sources

2. Process references: Organize, search, and annotate sources

3. Use references in writing: Add flexible references and 
bibliographies in your favorite word processing tools

4. Share references: Collaborate on gathering and processing 
sources



What does Zotero cost?

• Zotero is open source and free to use

• Yearly costs are only for file storage of attachments (PDFs, etc.)
• 300MB free, 2GB $20, 6GB $60, unlimited storage $120

• Zotero groups use the storage subscription of the group owner. Group 
members do not pay for storage used by the group, only for storage used by 
their own personal Zotero libraries

• If you choose not to synchronize files to your online Zotero account, you will 
not use file storage

• If you accidentally exceed your storage limit, you will get a warning and the 
new files will not be synced. Zotero will not charge you automatically

https://www.zotero.org/storage?id=storage


Zotero sister projects

• Project of the Roy Rosenzweig Center for 
History and New Media

• Sister projects of Zotero
• Tropy https://tropy.org/

• Omeka https://omeka.org/

• Why use these tools? 
• Open source and not for profit

• Easy export

• By and for researchers

• If you work with legal materials or want to 
save citations in multiple languages: Juris-M



Information, help, inspiration

• Zotero Quick Start Guide

• Zotero documentation

• Zotero forums

• Tips and tricks

• For inspiration: Zotero plugins

• Zotero news and how-to’s on the blog of the Artes Research Team

• Explore Zotero menus and the Preferences pane, experiment!

Thank you!

https://www.zotero.org/support/quick_start_guide
https://www.zotero.org/support/
https://forums.zotero.org/categories/
https://www.zotero.org/support/tips_and_tricks
https://www.zotero.org/support/plugins
https://scholarlytales.hcommons.org/tag/zotero/


Basic Zotero setup (1)

You need: 
• The Zotero desktop application, to work in

• The Zotero plugin for your browser, to gather references

• A Zotero account, to synchronize your references to the web interface and 
to participate in Zotero groups

• The Zotero web interface is mainly useful for displaying references openly. 
The desktop application has much more functionality

• Zotero has numerous plugins that are optional, but greatly expand the 
functionality of the program



Basic Zotero setup (2)
1. From https://www.zotero.org/download/, download and install the Zotero 

desktop application.

2. From the same page, install a browser plugin (Zotero Connector).

3. In the Zotero desktop application, go to Edit > Preferences > Sync and enter 
your Zotero account details to sync Zotero data to your online account.

4. To join a Zotero group, log in to the Zotero website in your browser, go to the 
group URL, and request to join. Depending on the group setup, you will be 
admitted automatically or after a group admin approves the request.

5. Minimum recommended plugins: Word processor plugin, Zotfile for easier file 
management 

• Zotfile (download via http://zotfile.com, install via Zotero app > Tools > Add-ons >         > Install add-on 
from file)

• Plugin for your preferred word processor (install via Zotero app > Edit > Preferences > Citation tab)

6. Done!

https://www.zotero.org/download/
http://zotfile.com/


Optional: play in our Zotero sandbox
• The Artes Digital Scholarship Community is a Zotero group full of 

resources on digital scholarship for KU Leuven researchers, 
students, and staff, curated by the research team of the library of the 
Faculty of Arts.

• To join the group, simply log in with a free Zotero account and click 
the "Join" button. When you join, you can add your own resources, 
see the content of attachments, and search this group right from 
your own Zotero desktop client. If you're not a group member, you 
can still browse and search the content of the group.

• The group also contains a “Sandbox” folder where you can change 
anything you like while you try out Zotero.

https://www.zotero.org/groups/2486238/artes_digital_scholarship_community
https://kuleuven.be/
https://scholarlytales.hcommons.org/


Gather references
Add (meta)data about, and copies of, scholarly sources



How to get materials into Zotero

1. From online sources, using the browser plugin

2. From files on your computer

3. From your existing bibliographies

4. From Zotero groups that you join

5. From RSS feeds



1. Get references from online sources

1. Using the browser plugin, 
Zotero can pull citation 
metadata about sources 
directly from web pages 
into the Zotero desktop 
app

2. Works with academic 
publications and other 
types of sources, including 
standalone PDFs, 
websites, social media, …



Result: Metadata and copy of item (web 
page snapshot or PDF) appear in Zotero



In-depth: Saving references from online 
sources with the browser plugin
1. How to save references

1. Click the Zotero icon to save a reference
2. Choose where you want to save the reference
3. If Zotero detects multiple references on a page, select which you want to save

2. Where does this work? 
1. Academic publications: Websites of journals, publishers, libraries, other academic platforms 

(data repositories like Zenodo, academic search engines like Google Scholar, etc.)
2. Other types of sources: Web pages, YouTube videos, social media posts, etc.

3. What information does Zotero pull into the app?
1. Metadata needed for citation (author, title, abstract, publication year, etc.)
2. Copies of the references, if available (PDFs of academic publications, HTML snapshots of 

web pages or social media posts)
1. Zotero integrates with Unpaywall to automatically find and save open access copies of papers across the 

Internet, not just on the current page
2. You can add the latest downloaded file to a Zotero item as an attachment (requires Zotfile)



2. Get references from files on your 
computer

• Any file of any format can be added to Zotero via drag and drop

• Drag single or multiple PDFs into Zotero

• Use Zotero functionality to manipulate PDFs (see next slide)



Some things Zotero can do with PDFs

• (Functionality may 
require plugins)

• Save, open, and annotate in 
Zotero

• Rename to consistent, tidy 
file names from parent 
metadata

• Index file content and do full-
text search

• Apply OCR (optical character 
recognition) to make PDFs 
searchable

• Extract existing annotations 
made in other programs



Installing Zotero plugins

• Zotero has a very wide range of 
plugins that add extra functionality and 
connect Zotero with other software 
and platforms.

• To find and install plugins, follow the 
(simple) instructions at 
https://www.zotero.org/support/plugins

https://www.zotero.org/support/plugins


In-depth: Turning PDFs into Zotero items 
that have structured metadata
• When the PDF has been OCRed: right-click > Retrieve metadata for PDF 

automatically searches for and adds the metadata associated with a PDF
• Condition 1: the metadata for that PDF is already findable online (this is often not

the case for rare sources)
• Condition 2: the PDF is searchable. To make a PDF searchable, apply Optical 

Character Recognition (OCR). This can be done in an external OCR program or, 
via a plugin that requires considerable setup, automatically within Zotero. OCR also
makes the full text of a PDF searchable from the search box!

• When the PDF has not been OCRed:
• Find the source online and save the metadata to Zotero via the browser plugin. This

creates a separate Zotero item. Drag the PDF onto the new Zotero item
• Alternative: right-click on the PDF in Zotero, select “Create parent item,” and add

the metadata by hand



In-depth: Finding PDF copies of Zotero 
items you only have metadata of (1)

• Select (multiple) files > right-click > 
Find Available PDFs automatically
searches for and adds the metadata 
associated with PDFs (via Unpaywall)



In-depth: Finding PDF copies of Zotero 
items (2)

• Use the Locate menu (the green arrow at the 
top right when an item is selected) to find an 
item in Google Scholar, various libraries, etc. 
Instructions for adding lookup engines

https://www.zotero.org/support/locate


In-depth: OCR of PDFs in Zotero

To enable OCR of PDFs, integrate Zotero with free Tesseract OCR 
according to the instructions at https://github.com/UB-
Mannheim/zotero-ocr

• Install Tesseract OCR https://github.com/UB-Mannheim/tesseract/wiki

• Install Popplr https://blog.alivate.com.au/poppler-windows/

• Check "Overwrite the initial PDF with the output" in the Zotero OCR settings

• Now when you select Zotero items and right-click "OCR selected PDFs", 
OCR takes place and the original PDF is replaced with OCRed version

• Now Zotero can at least index the PDF and make it full-text searchable. It 
may also be able to retrieve metadata, if metadata for the file is available 
online

https://github.com/UB-Mannheim/zotero-ocr
https://github.com/UB-Mannheim/tesseract/wiki
https://blog.alivate.com.au/poppler-windows/


3. Get references from your existing 
bibliographies into Zotero

• Add items by hand

• Add items by identifier (ISBN, DOI, and others)

• Zotero can import bibliographies in structured data formats 
(BibTeX, RIS, XML export from other bibliography managers, 
and more)

• If you have a plain text bibliography, for example, in Word, 
convert that text into structured data so that Zotero can import it

https://www.zotero.org/support/adding_items_to_zotero#add_item_by_identifier
https://www.zotero.org/support/kb/importing_standardized_formats


In-depth: Converting a plain text
bibliography for import into Zotero

Instructions for converting an existing bibliography to a format Zotero 
can import:

• Paste the bibliography into https://anystyle.io/

• Check the resulting structured data for errors, correct if necessary 

• Export the structured data to BibTeX format

• Import the BibTeX file into Zotero (File > Import)

• If desired, have Zotero automatically search for available PDF copies of 
sources (select Zotero items > right-click > Find available PDFs)

https://update.lib.berkeley.edu/2018/02/07/extracting-references-from-an-already-created-bibliography/
https://anystyle.io/


Using Anystyle.io, step 1



Using Anystyle.io, step 2



Using Anystyle.io, step 3



4. Get references from Zotero groups

• When you join a Zotero group, the group library appears in the 
Zotero desktop application in the left sidebar, under your personal 
library

• Work directly in the Zotero group (your changes will appear for all 
group members) or drag references from the Zotero group to your 
personal Zotero library (your changes will appear only to you)

• Easily exchange items between personal and group libraries



5. Get references from RSS feeds
• Journals, blogs, news sites, other websites, …, frequently offer RSS 

feeds of content updates. RSS = "a web feed that allows users and 
applications to access updates to websites in a standardized, computer-
readable format. These feeds can, for example, allow a user to keep track 
of many different websites" (Wikipedia)

• Zotero libraries, collections, and tags also have RSS feeds

• Add RSS feeds to Zotero to get updates from sites and add them to a 
library

https://en.wikipedia.org/wiki/RSS
https://www.zotero.org/support/feeds


Process references
Organize, search, and annotate sources



Use Zotero to manage your research 
workflow

• Built-in organization, 
annotation, and writing 
features

• Many plugins to fit your 
workflow

https://www.zotero.org/blog/zotero-6/



Organization options inside Zotero

• Tags, folders (“collections”), subfolders
(see next slides for details)

• Scan Zotero for duplicates and merge
them

• Scan Zotero for unfiled items (items 
that have not been sorted into any 
folders)



In-depth: Tags and folders/collections

• Folders/collections
• New items are automatically saved into the collection selected at the time
• One item can be placed in multiple folders by dragging it from one folder to 

another
• These copies reflect the same item: changes to one copy are reflected 

everywhere
• To move a file from one folder to another, first drag it and then delete the 

original
• To see all the collections an item is in, select the item and then hold 

down the Option (Mac), Control (Windows), or Alt (Linux) key

• Searching/sorting: Click a folder and then a tag in the tag selector to 
show only items that match both



In-depth: Tags and folders/collections

• Add tags from the pane to the left, as many as 
desired

• Assign tags to items and notes separately

• Assign colors to main tags to visualize tag 
assignations in item lists

• Searching/sorting: Click a folder and then a tag 
in the tag selector to show only items that match 
both

• Tip: In Edit > Preferences > General, disable 
“Automatically tag items with keywords and 
subject heading” to keep Zotero from 
automatically pulling in unwanted tags when you 
save an item via the browser



Quick search

• Quick search box at the top of the item list:
• Search in Title, Creator, and Year

• Search in all metadata and tags (including abstracts and notes)

• Search in everything, including full text of attachments (works for
PDFs that are searchable and plain text files, check that PDF 
indexing is enabled in Preferences)

https://www.zotero.org/support/searching


Full-text search inside Zotero

• Works on (searchable) PDFs, web page snapshots, plain text files 
including markdown, notes



Advanced search pane: combine search 
filters to construct complex queries

Example: search 
inside the Artes 
Digital Scholarship 
Community Zotero 
group for all items 
with a PDF 
attachment that 
contains the word 
“format(s)”

(% is a wildcard 
character)

https://www.zotero.org/groups/2486238/artes_digital_scholarship_community


Saved searches

• Any advanced search can be 
saved to avoid having to 
reconstruct it over and over

• Saved searches appear as 
automatically updated folders 
at the bottom of a Zotero 
library

• Saved searches can be 
reused as folders in new 
quick or advanced searches

• Right-click on a saved search 
to edit its parameters



Add columns, multiple sort options

Example: sort by items that have an attachment



Notes in Zotero

• Add rich-text notes to references

• Add standalone notes not connected to particular references

• Zotero notes can have their own tags and are searchable



In the new Zotero 6, you can also…

• “Open PDFs in a new built-in reader within the main Zotero 
window, in a new tabbed interface

• Clean up metadata for items while viewing your PDFs

• Mark up PDFs with highlights, notes, and image annotations

• Add annotations to Zotero notes with automatic citations, in 
a powerful new note editor

• Cite other items directly in notes using Zotero’s familiar 
citation dialog

• Insert notes into your Word, LibreOffice, and Google Docs 
documents with active Zotero citations for automatically 
generating bibliographies

• Export notes to external Markdown editors with links back to 
Zotero items and PDFs”

https://www.zotero.org/blog/zotero-6/



PDF annotation in Zotero



Inserting PDF annotations into notes (1)

• Annotations inside PDFs can be inserted into notes

• Annotations in notes become full-fledged references:
• Jump from a note back to the annotation in the context of the pdf

• Create automatic bibliographies including references from annotations

Write output directly in Zotero notes before moving to Word



Inserting PDF annotations into notes (2)

• In practice:



Using other PDF annotation options 
together with Zotero

• Change settings so that Zotero opens PDFs in the default PDF 
reader program

• The Zotfile plugin can extract existing annotations inside PDFs to 
Zotero notes



Work across devices

• Zotero syncs libraries across devices, for example, 
between Zotero desktop apps on different computers

• Work in the browser

• Work offline in the desktop app

• iOS app currently being tested



Important note about syncing

• You can move Zotero data, including the database and the
attachments, to a different default directory via Preferences. 

• Do not move the Zotero database on a cloud storage service 
like OneDrive to sync it between devices. Putting any kind of 
database on a cloud storage service can lead to data loss. Always 
use the Zotero sync functionality to sync between devices.



New: Free iOS app



Use references in writing
Add flexible references and bibliographies in your favorite word processing tools



What programs can Zotero interact with?

• Plugins for common word processors: Word, Google Docs, 
LibreOffice, …

• Third-party plugins/integration with other writing programs: RStudio, 
Jupyter Notebook, LaTeX, Atom Editor, markdown, …

• Workarounds for use in other programs: Usually developed by 
individuals, search [PROGRAM NAME] AND Zotero

• Example: How to use Zotero with Scrivener

https://www.zotero.org/support/word_processor_integration
https://www.zotero.org/support/plugins
https://phdprogress.com/how-to-use-zotero-with-scrivener-part-1/


Example: The Zotero menu in Word

1. Add/Edit Citation: Search for a reference from 
Zotero and insert it into a text (there are keyboard 
shortcuts too)

2. Add note: Search for and insert the text of a note

3. Add/Edit Bibliography: Insert an automatically 
generated bibliography at the end of a text

4. Document preferences: Switch between citation 
styles, for example, to submit to different journals

5. Refresh: If changes don’t appear right away

6. Unlink references: Remove the connections 
between the references and Zotero. Once you do 
this, you may only be able to edit references by 
hand.



Zotero in Word, step 1



Zotero in Word, step 2



Zotero in Word, step 3



Insert note text from Zotero into Word

• Insert note text 
directly into 
publication text 
in Word or other 
text editors

• Also handy for 
notes that are 
quotations!



Other export options

• Zotero can also export references as plain-text bibliographies in a 
range of citation styles

• Data from Zotero can be exported in a range of formats (CSV, XML, 
Dublin Core, TEI, Wikipedia citation templates, …)

• Other export/integration/display options: Timelines, visualizations, 
displaying Zotero libraries on a website (WordPress, Omeka, …)

• See the Plugins page for inspiration



Share references
Collaborate on gathering and processing sources



Neat things to do with Zotero groups

• Discover relevant sources via references added by colleagues

• Give all members full-text search of everyone’s references

• Distribute and simplify work of gathering and managing references
• Minimize time spent hunting down sources, create automatic naming rules

for PDF attachments, detect duplicates, …

• Link a project’s reference library up with external tools (via plugins or 
via data export) to enable additional research/analysis

• Visualization, text analysis, … Anything that can import structured data

• Make an extra publication out of the bibliography
• Export it and add it to a data repository (easily findable, citable via DOI)
• Import it into a project website (WordPress, Omeka, …)



How do groups work?

• Group libraries appear under personal libraries in the Zotero app 
and in the web interface

• Group libraries have the same functionalities as personal libraries
(search, etc.)

• Changes to group libraries are synced to all members
• New or deleted references
• Changes or additions to metadata
• Changes to files (new file, PDF was OCRed by group member, …)

• Groups can be open (=visible in group search on Zotero) with open 
membership, open but with restricted membership, or closed (=not
visible in group search on Zotero) and with restricted membership



Copyright: Which files can groups share?

• Files whose copyright license allows redistribution
(Creative Commons, some other licenses
associated with open access publications): Can be
shared in any group that allows file sharing

• Files whose copyright license does not allow
redistribution (“traditional” copyright): Can only be
shared in closed groups whose members are KU 
Leuven staff only

• Questions? auteursrecht@kuleuven.be



In-depth: Solving possible issues with
Zotero groups

• Sync conflicts: Zotero will present conflicting items side by side to
have them merged or one chosen over the other

• Accidents that have been synced to everyone (unwanted
deletions, modifications, …): If the problem is small, fix it by hand, 
then sync again. If the problem is difficult to fix by hand, check the 
many options for restoring backups of the Zotero library in question

• Duplicate entries: Can be checked and merged in the left sidebar

• Organizational chaos: Make clear agreements about group
members’ responsibilities

https://www.zotero.org/support/zotero_data


Optional strategies to keep things organized

• Make it easy for people to organize things the way they should:
• Agree on simple rules for organizing that everyone can remember and follow

• Make the folder structure simple and intuitive

• Put a note in a prominent place, describing organization principles, tags, …

• Make an Inbox folder for uncategorized items

• Make a Sandbox folder for experimentation

• Appoint one person as the group “librarian” and make them responsible 
for occasionally cleaning and organizing newly added sources (e.g. by 
checking for unfiled items, checking metadata of newly added items, …). 
This could be a rotating position too

• Schedule a Zotero library cleanup moment every x months (together with 
regular project meetings/data management checkup moments?)



In-depth: Finding/backing up Zotero data

• Check the Zotero Preferences to find the folder where Zotero data is 
located

• Zotero stores two kinds of data:
• Metadata, notes, tags, library structure, etc.: zotero.sqlite file

• Backup files: zotero.sqlite.bak

• File attachments: “storage” subdirectory

• Best way to create backups: Use backup utility to back up entire 
hard drive, including Zotero data

• Is data missing? Before you take any actions, disable auto-sync in 
the Sync pane of the Zotero preferences and check the many 
options for restoring backups

https://www.zotero.org/support/zotero_data
https://www.zotero.org/support/zotero_data


In-depth: Storing attachments in a separate 
directory outside the Zotero database

• Go to Preferences to change 
attachment storage from inside
the Zotero base to a separate 
directory (“linked attachment base 
directory”), for example, to a 
cloud storage service like 
OneDrive. 

• This only works for attachments 
to personal Zotero libraries, 
attachments to group libraries 
(the risk of individual members 
making problematic changes to a 
separate attachments folder 
would be too high)



Juris-M
A Zotero offshoot with extra features for law research and multilingual 
bibliographies



Juris-M

• “Fork” of Zotero

• Specialized 
features for law 
research and 
working with 
multilingual 
bibliographies

https://juris-m.github.io/



Benefits of Juris-M

✓ Deep-down it is just Zotero 
(version 5)

✓ Support for additional Item-
types:
Bill, Case, Legal Commentary, Patent, 
Regulation, Standard, Statute, and Treaty.

✓ Comes with included lists of 
Jurisdictions and Courts.

✓ Better support for 
abbreviations.

Benefits of Zotero

✓ More features with Version 6

✓ Support for Legal Sources and 
citation-styles (V&A, OSCOLA) 
is there as well

✓ Knows about ECLI-numbers 
(Juris-M doesn’t!)

Faculty of Law67

Zotero vs Juris-M for law research



Moral: a 
certain amount of 
manual editing is 

inevitable

▪ National databases do not work as expected with Zotero/Juris-M
✓ Zotero-connector saves everything as a webpage.

✓ JURA and Stradalex require substantial manual edits

✓ Jurisquare has a dedicated “Citation manager” button that works, except for the 
pdf.

▪ International databases work somewhat better
✓ Hein-online works well with the connector

✓ Westlaw simply doesn’t

▪ Some publishers aren’t very helpful either
✓ Connector does not work with Kluwer Law Online, but you can export references 

as RIS-files

Faculty of Law68

Some worries for users of 
legal databases



Using Juris-M to manage multilingual items 
in bibliographies (1)
• Juris-M started out as “Multilingual 

Zotero” and still has interesting extra 
features for those working with multiple 
languages

• Example: An item with a title in 
Japanese characters, that title 
transliterated to Roman characters, and 
a third title that is the translation of the 
original Japanese

Extra fields to add variant titles

Screenshots from: https://juris-m.readthedocs.io/en/latest/tutorial.html



Using Juris-M to manage multilingual items 
in bibliographies (2)

Especially relevant when citing items in: 

• Articles in different languages

• Journals requiring variant forms in citations, e.g. the transliterated 
and translated form of a title



Workshop slides
Useful slides when using this guide in a workshop/training



Workshop outline

1. Get everyone set up with the Zotero essentials

2. Quick overview of what Zotero can do, also for research teams

3. Closer look at Zotero features of interest to this team:
• Discuss individual/team workflows for handling references: What are we 

already doing, what do we want to change or try? What workflow do we want 
to use?

• Determine Zotero features of interest for team (if no obvious consensus 
emerges: vote to rank Zotero features from most to least interesting)

• Cover as many interesting features as possible in the rest of the workshop



Group discussion prompts

• How do I/we currently manage sources (metadata and file copies)? What
are the main issues with that workflow?

• What’s my/our ideal workflow? (Think big)

• Any Zotero functionality that might help?

• How do we like our existing Zotero group? Is it clear and easy to use? Do 
we think it can be improved?

• What new possibilities emerge when we share references as a team?

• Can we publish the Zotero group library in some form to benefit other
researchers/increase the impact of our work?

• …



What Zotero functionality do we want to look 
at in-depth?
1. Closer look at the Zotero interface

2. Closer look at plugins that add functionality to Zotero

3. Saving references from online sources with the browser plugin

4. If you have a Zotero item with metadata: how to find/add a PDF?

5. If you have a PDF: how to turn this into a Zotero item with metadata?

6. OCR of PDFs in Zotero

7. Converting a plain text bibliography for import into Zotero

8. Search options in Zotero

9. Using the Word plugin

10. Tags and folders/collections

11. Zotero notes and PDF annotations

12. Other suggestion/we want to do something else with the rest of our time

https://www.zotero.org/support/plugins

